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Programma avanzato per la creazione di frattali:

= Shareware

= Presenta un public database

= Formule frattali, algoritmi colore e trasformazioni sempre aggiornate e nuove

= Crea animazioni

= Puoimportare e modificare le foto con gli amici

= Presenta trasformazioni che possono creare effetti strabilianti alle nostre foto

= Pulsante “"Explore” e "Thumbnails Browse” per vedere in anteprima e come
verra modificata I'immagine senza aspettare il completo caricamento

= Crea maschere e lavora con i gruppi

= Compiler avanzato per la creazione di formule

= Possibilita di connessione remota per velocizzare il calcolo

= Crea Jpeg, Tiff, Photo Shop file(.PSD), Avi file, bitmap, Png e Targa Image

= Etantoaltro....

Forum/lista di condivisione(in lingua inglese)

Programma intuitivo

Versatile, puo essere usato in unione con altri programmi(PhotoShop o

Apophysis)

Lavora con diversi “pannelli” come fa PhotoShop
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Figura geometrica complessa(oggetto

geometrico) che siripete, nella forma,all’infinito

Autosimilare su diverse scale di zoom

E sviluppato sul piano complesso

« E rappresentato da numeri complessi e cioé che
hanno una parte Reale ed una parte

_ Immaginaria=z=(x+yi)

E rappresentato da una successione che:

= Converge

= Diverge

| set frattale principale prende il nome dal

matematico che li ha scoperti:

SET DI MANDELBROT
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A fianco degli esempi di
frattali in natura.

E importante
sottolineare che la
geometria frattale &
capace di rappresentare
qualsiasi forma presente
in natura.

Tutte le forme possono
essere rappresentate
tramite algoritmi
frattali.

In UF per esempio
abbiamo degli algoritmi
che disegnano laghi,
montagne e tanto
altro...
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= Autore:

= Frederik Slijkerman

= Varie versioni:

= Sito di download:
http://www.ultrafractal.com
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http://www.ultrafractal.com/
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File Edit Gradient Options
]
C]]

Window Help
B 6|

Fractall

* Hue/Saturation/Luminance
* Dpacity

|
:' Rotation:
» Position:
Op H

> __Comments

1 control point(s) selected
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"Location | Mapping | Formula | Inside

Smooth {(Mandelbrot)
Color Density:

Transfer Function:

Solid Color:

Gradient Offset:

ayers | Image tory | Comments

anrmaI !g LR B m

WEr <:] Background

The red, green, and blue curves enable
you to edit the control points of the
gradient in RGE mode. Click and drag a
control point to change its position and
red, green, or blue value. Use Shift and
Ctrl to select multiple control points.
Press F1 for more information

Window Pane




La Toolbar presenta delle
icone con comandi rapidi
spiegati qui di fianco inoltre
da:

File = Si puo creare un nuovo
frattale, immagine frattale,
oppure delle nuove formule,
tipo formula frattale,
algoritmo colore,
trasformazione, libreria di
plug in e gradient.

Edit= Funzioni di copia e
incolla ed undo e redo dei
comandi.

Fractal= funzioni relative
alla finestra frattale, quindi
possibilita di zoom,
visualizzazione modo
normale, switch...
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Avanti comando N _ _
Indietro comando Copia i parametri Incolla i parametri

Salva il file

Apre il browse parametri

Apre un file esistente
Nuovo frattale

File Edit Fractal Animation Options ‘Window Help

b %om| ORI Y & B o

Help

Apre la finestra per render in jpeg o altro

Finestra frattale Salva i parametri

In normale modo :
di visualizzazione \Apre lo switch mode

Apre Gradient
Seleziona un area
da poter zoomare




" Fractal

.« Color Chrl+F2

Opacity Ctrl+F3

Link Color and Opacity  Cerl+L

w* Smooth Curves

Randomize
Randomize Bright
Randomize Misty
Randomize Custorm...

Adjust Colors. .. Ctrl+]

Reverse

Invert
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= Possiamo passare da fractal a gradient, se si passa a
gradient si aprira la finestra del gradiente ed al
posto di fractal nella toolbar verranno visualizzate le
funzioni del gradiente, che sono di fianco a sx nella
diapositiva e sulla toolbar; quando passiamo a
gradient in automatico UF converte la toolbar per il
gradient, quindi se attiviamo il gradiente ed
andiamo in File=>Save As, salveremo il gradiente,
per ritornare a fractal basta cliccare sulla finestra del
frattale.

File Edit Gradient Options Window Help

RO < am

Gradiente selezionato

Selezionando il gradiente, UF sostituisce
automaticamente nella tool la visualizzazione con
le funzioni del gradiente, per tornare alle funzioni
fractal cliccare su fractal, sulla finestra frattale o
sull'icona di fianco a sx dell'icona gradient




Un passo importante quando
scaricate il programma e
indicare ad UF dove trovare i
files, quindi la localizzazione del
percorso, per fare questo
andiamo in
Options—=>Options>Folders e
selezioniamo tutti i percorsi
corrispondenti.Quando
installate UF creera una cartella
in documenti con tutte le
sottocartelle adibite al
salvatag(?lo e apertura dei
file.Qui di fianco un esempio di
come fare..., a vostro
piacimento potete creare le
cartelle pit comode e salvare il
percorso.Formula Library e
Public Formula e riferito alle
formule che scaricherete e
aggiornerete settimana per
settimana dal database.
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Options

"Mouse YFracta| TDefauIts TGraduent TEdltor YSyntax TBrowser TEnwronment Wdﬂ’s |

’TUIUUI >

Description

Fractal files

Exported images
System Folder
Parameter library
Gradient library
Formula library

Public formulas

Help on formulas
Image library
Additional search paths

Location

DocumentiiUltra Fractal 512013
DocumentiiUltra Fractal 512013
DocumentiiUltra Fractal S\Images
Application Data\Ultra Fractal S
DocumentiiUltra Fractal S\Parameters
DocumentiiUltra Fractal S\Gradients
DocumentiiUltra Fractal SiFormulas
DocumentiiUltra Fractal S\Formulas\Public
DocumentiiUltra Fractal SiHelp on Formulas
DocumentiiUltra Fractal S\Images

Open fiié_s in:

lDocumenti'l,UItra Fractal 512013 | :

T8

[v]Remember last location

hanges to the ,'emfolderwﬂfakeeffectﬂmenexttme
start Ultra Fractal,
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Nella finestra del “default” Options 2
pOtete invece settare i comandi "Mouse | Fractal ’ Defaults ‘Gradient | Editor | Syntax | Browser | Environment | Folders |

d| altezza e |arghezza de”a ~Default image settings vy Default comments and copyright notice——————
finestra frattale all'apertura del width:  |640 ||
programma, con valore di Height: 480 QY #7°1Freeeeicome
risoluzione ef_gamm?j, inoltre C I Ommile o ek ook
inserire una firma o dei
commenti che saranno N
visualizzati in “layers ik . |
properties”=>Comments, e dove B <
aprire i default parametri, per i Gamma: |25 | o
: Copyright: | |
parametri consiglio di lasciare le [ Override parameter set L T |
bl - 2al H ractalCosmo.

iImpostazioni predefinite di UF ed i £
anche per i valori dirisoluzione e Eor——
gamma_'Rl‘cord_ate ancr)le dl IDocumentl'gUItra Fractal S\Parameters\Examples.upr | e
andare in “"Enviroment = &

5 ,,]Default
mettere il vostro nome e it

cognome o la vostra firma
artistica.
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In Options—> Fractal & bene ’ Options
Spu ntare “"Com press Defaults TGradient TEditor TSyntax TBrowser TEnvironment TFoIders 1

"Mouse | Fractal

param eters la rger than 2kb” ~Fractal window options \  Parameter sets
perché, se condividete nella 2w, Soupres: Baranete sl aor i 210
I/

lista i vostri frattali, avrete un Hecimenheign: e s

= i B d color: .
codice P1U COMPresso € ackurpurel s [:] L [ ]when fractal window finishes ¢ &=
condivisibile.Peril resto Use crosshair mouse cursor [ Jiherirender job Fiishes ¢ =
spuntate anche “Use Crosshair [V] sk to save when closing

mouse” cosi quando il cursore

files. Sounds are played only if the

J \il) Use the buttons to select and test sound

~On new fractal \ 2 -
\ . . calculation took more than one minute to

sara sulla finestra attiva @ sbrt Foriaia Finish,
dIVE Nntera automaticamente un " Load default parameter set |
“mirino” ed @ molto P iU comodo ;-Use ey s *  ~advanced calculation options ~
che avere la solita freccia del e enoin ouesss b ok
mouse O When necessary Hladman EeamCey Of v sece; £

; : : Animation preview fpsk |10
Il resto delle finestre lasciatele ' Blways riteon previes speec (i)

in default, ad esempio in
gradient lasciate tutto bianco
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UF presenta vari tipi di files:

* Fractal Formula file(.ufm)
= Coloring Algorithm file (algoritmo colore .ucl)
= Transformation file (algoritmo di trasformazione .uxf)

= Plug In Library (libreria di Plug In file .ulb), presente
solo in UF 5.0 non nelle versioni precedenti

= Parameter files(.upr)
= Gradient files(.ugr)
= Fractal file(Quando salviamo un frattale file .ufr)
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Le formule e i files possono essere:
= Caricate sul public database

= Private e create da noi grazie al formula editor di
Ultra Fractal(non vedremo in questo introduzione)

Per scaricare le formule e i files frattali,
trasformazione e colori del public database:

= Da UF : Options === Update Public Formula
= Dal link : http://www.formulas.ultrafractal.com/
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http://www.formulas.ultrafractal.com/
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Le formule frattali creano la forma base
dellimmagine da cui vogliamo partire, a fianco
per esempio abbiamo la formula di
“Mandelbrot”.Possiamo scegliere vari tipi di
formule di partenza andando in file “File=>New
Fractal”.

Nella ToolWindow di Layer Properties avremo
tutta la formula con diverse possibilita per
cambiare i parametri dell’equazione e quindi
I'immagine risultante, in questo caso, la
formula di Mandelbrot presenta 3 parametri.
Starting point, che equivale al valore che
daremo a Z in questo caso si parte da Z=(Reale,
Immaginario)=(0.0, 0.0)

Power=(Re, Im) = (2.0, 0.0) che rappresenta
I'esponente dell’equazione di Mandelbrot
(z=z"Power+c) quindi dato che power=2.0,0.0,
z=zN2+C

Bailout Value che rappresenta, in generale
senza soffermarci troppo ai tecnicismi, il punto
per il quale la condizione di giusta
rappresentazione dell'insieme e
soddisfatta.Noi lasceremo sempre 128, mail
set di Mandelbrot e soddisfatto per un valore di
BailOutda 4 insu.
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Location

Mandelbrot

Drawing Method:

Periodicity Checking:

Additional Precision:

Maximum Iterations:

Mapping Formula

_Inside

™ c
Normal M F_}f
g ™ 2
50 IEEZ

[ ] adjust Automatically

Guessing

Starting ... |0
Starting ... |0
Power (... |2
Power {(I... |0
Bailout v...

15




Laver Properties - Fractall, Backzround

"Location |Mapping " Formula ‘Inside IOutside |

Mandelbrot °:3
Drawing Method: [Guessing @ C
Periodicity Checking: E\lormal r;;] |}4
Additional Precision: EJ "&71 ?
Maximum Iterations: ESO 'V‘ L4

[ ] adjust Automatically

Starting ... iO l
Starting ... [U J
Power (... ir3 I
Power (I... [0 l

|

Bailout v... i128

In questo caso abbiamo cambiato I'esponente cioe
il power a (3.0,0.0) ed abbiamo l'immagine
risultante quindi z=z"3+c dove c=pixel e vediamo

come cambia il set al cambiare dei parametri.
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ound SB

"Location TMapping TFormula [Inside Outside I
@

]

, Orbit Traps
Color Density: [1 "4 G
Transfer Function: [Linear Rﬂ |'_.!,§
Solid Color: _ ?
Gradient Offset: EJ "71 7
Repeat Gradient
Trap Sh... [ring 2 "d
Diameter: i 1.0 ‘
Trap Col... |distance vl
Trap Mo... [closest hﬂ
Thresh... [0.25 |
~ Options
Trap Ce... {U ‘
Trap Ce... iD |
\ Aspect .., {1.0 |
|

Rotation: iD.U

[ Tuse Solid Color
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Nella diapositiva precedente abbiamo inserito un
algoritmo colore per colorare I'esterno del set di
mandelbrot, abbiamo usato le “orbit traps” nella cartella
standard.ucl del public database.Possiamo notare che
abbiamo settato il parametro dell’algoritmo colore “Trap
Sh...(Trap Shape)” in "Ring2" e si puo ben vedere l'effetto
della curva ad “anelli” intorno al set di Mandelbrot.Ma
andremo a vedere piu approfonditamente le opzioni e i
parametri dell'Outside Color” piu avanti.

Per il momento dobbiamo sapere che possiamo scegliere
una formula frattale(quindi un file .ufm) e nell’'outside
color con il bottone “browse” possiamo scegliere un colore
da abbinare alla nostra formula.
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Fractall

"Location TMapplng TFormula * Inside iOutsn:le

Orbit Traps .
Color Density: [1 M C
Transfer Function: [Sqrt M E;‘
Solid Color: ,:‘ ?
Gradient Offset: [3 M 7

Trap Sh... lring 2

Diameter: |1 .0

™

|

Trap Col... [distance M
¥

|

Trap Mo... [closest

Thresh... |0.25

~ Options
Trap Ce... IO
Trap Ce... ID

'ﬁsDe':t i |12
e ek clr

I N e
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Con lo stesso procedimento dell‘outiside color possiamo inserire
un Inside color, in modo da andare a colorare la regione, di base
colorata di nero, dell’'interno del set di Mandelbrot.Abbiamo
sempre usato “"Orbit Traps” in standard.ucl e "Trap Shape” in
"ring2"” ma abbiamo cambiato I'aspect ratio e la transfer
function.Vedremo piu avanti le funzioni con maggior dettaglio.Da
precisare che nell'esempio, vediamo l'esterno di mandelbrot
sempre il “blu” questo succede perche in Outside color abbiamo
lasciato la “transfer function=linear” se invece avessimo messo
“transfer funtion=none"” (cioe nessun colore) avremmo tutto
I'esterno del set in nero mentre all’'interno del set I'inside color;
possiamo quindi lavorare con due colori
contemporaneamente(quando il set ha le due regioni, interne ed
esterne che lo permettono)usando un colore per la regione interna
ed un colore per la regione esterna, NON NECESSARIAMENTE
GLI STESSIALGORITMI COLORE...Un esempio nella diapositiva
successiva...
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In questo caso abbiamo usato sempre la formula Mandelbrot
ma con due colori diversi per la regione interna ed
esterna.Internamente abbiamo usato “Orbit Traps” ed

Layer Properties - Fractall, Background

Locatton TMapplng TFormuIa ' Inside 10utsu:|e I

| Layer Properties - Fractall, Backeround. | =

Location Tﬂ@pp@ﬂFormula Tlnside T5ﬁ?side’1_

f-:st.ernamente “Gaussian Integer”, i colori lavorano Orbit Traps @ BB ussian Integer @& |
indipendentemente. 1 1
NB:In questo caso i colori ovviamente lavorano Color Density: it ¥ & | Color Density: it ™ c
indipendentemente ma il gradient & sempre uno sia peril TrareFar Fechon: [sart 9 ¢ | ranser Function: [inear M ps
colore esterno che per quello interno, in UF possiamo pero :

usare due layer distinti, uno per colorare la parte esterna ed AT l:} 7 Jfpeld Color: l:‘ ?

uno per quella interna in modo da avere anche due gadient Gradient Offset: o M L4

Gradient Offset; El M i
distinti..Dipende da quello che vogliamo fare

Repeat Gradient

TrapSh... [ring2 M n v {round(z) M

Repeat Gradient

Fractall

Diameter: |1.0 lminimurn distance M
Trap Col... [distance [none M
Trap Mo... lclosest [ Irandomize

Thresh... |D.25
~ Options
Trap Ce... |D I
Trap Ce... ID [

Aspect ... | 12 |
Rotation: 0.0 l
[ Juse Solid Color .
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In UF & semplicissimo inserire
delle trasformazioni per creare
diversi effetti ai nostri
frattali.Da layer properties
andiamo su “mapping” e Solid Color:
clicchiamo l'icona “add”, s

I

aprira il browse delle Water le... [0
trasformazioni, file .uxf, water le... [0
andiamo nella cartella tma.uxf [luse screen center
e apriamo “the compleat Angle: 0

Iake", vediamo che I'immagine [V]Use Location tab angle
e la stessa ma con l'effetto Amplitude;
acqua, dal tab della Distributi...

trasformazione

i . A " Frequen...
possiamo poi cambiare i o
c . ¢ recede..,
parametri per avere diversi -
: Periodicity:
settaggi dell’acqua, dalla ety
Wave T...

frequenza delle onde,
I'ampiezza, la distribuzione,
cambiare i tipi di onde
dell’acqua..etc...Possiamo
anche aggiungere tutte le
traformazioni che vogliamo,
una sopra l'altra nello stesso
layers.
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Abbiamo detto che
possiamo inserire tutte le
trasformazioni che
vogliamo, in base
all'effetto che vogliamo
dare.A fianco ho aggiunto
una trasformazione sferica
in questo modo avremo
I'effetto lago della
trasformazione
1"compleat lake” ed in piU
un effetto sfera, in modo
che il frattale con l'effetto
acqua sia racchiuso dentro
una sfera.

Per aggiungere una
trasformazione clicchiamo
sempre dal pulsante “add”
nella finestra “mapping"”.
Il solid color della
trasformazione Black hole
(in jos.uxf) colora l'area
nera intorno al frattale.
Possiamo poi cambiare i
parametri delle due
trasformazioni

| Location ' MBDD"'IQ'W Formula TInsude TOutsn:ie ]
Bl |

- The Compleat Lake

Solid Color:

Poincaré. .. | 1.0

Center (... |D.D

Center (... |IJ.0

[Juse image center
[ Turn off

Iteration... |5
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Abbiamo visto come iniziare a fare un frattale
scegliendo prima la formula frattale poi il
colore outside o inside in base alla regione di
lavoro e come inserire delle
trasformazioni.Nella finestra layer properties
rimane da dare uno squardo alla location tab
ed ad alcune funzioni interessanti di UF quali
il pulsante “explore” e “switch”.Poi
passeremo al colore e gradiente.
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In location tab possiamo cambiare
le coordinate del piano (center.
Re,Im), la magnification cioe lo
zoom, roteare I'angolo, distendere o
comprimere il frattale(stretch),
oppure cambiare I'angolo di
inclinazione del frattale(skew
angle).

Possiamo cambiare le coordinate
anche selezionando dalla toolbar
Iicona select mode e poi coniil
mouse roteare l'area che ci

interessa evidenziare, doppio click
per zoomare e attivare, mentre per
tornare indietro una volta che
abbiamo zoomato basta premere
pulsante destro(tenendo il mouse
sulla finestra dell'immagine) e
premere undo.
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Center {Re):

Right Bottom (Im):

Center (Im): IU |
Maanification: I 1 I
Rotation Angle: P H
Stretch (x/¥): fi IS
Skew Angle: o M M
Left Top {Re): |-2.5 |
Left Top (Im): 1.5 |
Right Top (Re): |15 ]
Right Top (Im): 1.5 |
Riaht Boton (Re) |
|
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MIETP=I©BRINT IF ORIV /A= 728

Apriamo da file>New : oo
Fr%ctal dalla cartella imth»::ijm%
standard Drawing Method: [one-pass Linear 1
“"Emossed(Mandelbrot)”, perscity Checking: [or 9 o
come possiamo vedere dalla  sunaprecson: M 2
formula tab: Masimum Iterations:  [100 R
Drawing Method=One-Pass [ Adjust Automatically
Linear Starting ... |0.0 ]
peridicity checking = Off Startng ... [00 |
additional precision=0 Exponent: (2.0 |
maximum iterations=100 Bal-out ... [4.0 |
Nel mio computer nella Emboss . [Tteration B
status bar il calcolo lght An... [0.0 |
dell'immagine ha un Contour ... 1.0 |

Elapsed time = 0:00:00.14 |
Nel vostro caso ci sara un |
valore in base alla velocita del Elapsed: 0:00:00,14
vostro computer, che puo
essere diverso dal mio
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Adesso invece
cambiamo,
mettendo:
Drawing
Method=Guessing
Periodicity
check=normal
Possiamo vedere che
I'immagine questa
volta non e calcolata
in modo corretto
pero I'elapsed time e
molto piu veloce,
infatti:
Elapsed =0:00:00.03
Anche nel vostro
computer il valore di
elapsed sara

comunque inferiore
rispetto a prima
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Laver Properties - Fract‘al?l-;:ﬁ;_, ] M e

"Location TMapping * Formula 'Inside [Outside l

Embossed {Mandelbrot) @
Drawing Method: [Guessing ’v} C
Periodicity Checking: [Normal fq B
Additional Precision: @ fv1 ?
Maximum Iterations: [ICIEI ’v’ <

[ ] adjust Automatically

Starting ... 0.0

0.0

Starting ...

Exponent: (2.0

Bail-out ... |4.0
Emboss ... [Iteration B
Light Ani... (0.0
Contour ... |1.0

Creato da Andrea Spinozzi

Elapsed: 0:00:00,03
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Abbiamo fatto questo
esempio per far capire
che il metodo di
“drawing” piU accurato &
“one-pass Linear” ma ci
mette piU tempo a
calcolare,ugualmente per
Periodicity check=off.
Consiglio per un accurato
metodo di calcolo e
buona velocita

drawing=multipass
periodicity=off.

Dipende anche dalla
formula che usiamo pero
in generale e corretto
mettere:
method = multipass
periodicity = off
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Layer Properties - Fractall, Bai -i"; . EBRE

"Location TMapping m’m_1
Embossed {(Mandelbrot) % :
Drawing Method: [Multi-pass Linear ’Vj (=
Periodicity Checking: [OFF R'] Bﬂ
Additional Precision: @ 'v} ?
Maximurm Iterations: [100 'v’ L4

[ ] adjust Automatically

Starting ... (0.0

Starting ... 0.0

Exponent: 112.0

Bail-out ... i4
Emboss ... [Iteration
Light An... |0.0 |
Contour ... %1.0 ‘ = ——
Elapsed; 0:00:00,12
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All'inizio abbiamo
detto che il bailout
rappresenta un giusto
valore per il quale la
successione e ben
definita e visualizzata,
teniamo per buona
questa definizione e
vediamo alcuni esempi
di bailout e relativa
visualizzazione del
frattale.

A fianco l'immagine
con
Emboss(mandelbro
t) e bailout=4

01/02/2014

rLocatlon TMapplng Formula ‘InSIde IOutsde l

Embossed {(Mandelbrot) %

Drawing Method:

Periodicity Checking:

Additional Precision:

Maximurm Iterations:

Starting ...
Starting ...
Exponent:
Bail-out ...
Emboss ...
Light &n...

Contour ...

[Muti-pass Linear 1% o
(o ™ ¢
; ® -
fr00 R

[} adjust Automatically

0.0

0.0
L

2.0

{4.0

[Iteration

0.0
|

|1.o
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Fractall

BAIL=10
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Una volta che abbiamo fissato il giusto valore di Bailout (64 per la
maggior parte delle formule va bene, ma per esempio non per i
frattali Newton che usano altro metodo di bailout ma in generale
lasciate quello di default ) dobbiamo utilizzare le giuste massime
iterazioni, pil aumentiamo la scala, lo zoom, del frattale piu UF
avra bisogno di incrementare il calcolo delle iterazioni.Qui di
fianco faré un esempio in modo da capire visibilmente come si
comporta il programma e la precisione del calcolo.

La formula usata & sempre embossed, il bail out = 64 ma anche 10
come valore va bene poiché la successione € comunque
soddisfatta pero vediamo che pit aumentano le max iterazioni

P“‘J I Punti a”'intel’no del set Vengono disegnati Layer Properties - Fractall, Background 7)™ Layer Properties - Fractall, | roun [&]&)
“Location ]Mapping ]Formula [ Inside [Outside 1 ’ Location TMapping " Formula ]Inside fOutside |
Nella location vedete che la magnification =198677.78 Center (Re): [-1.4703348204443¢ ||| Embossed (Mandelbrot) @&
Center (Im): [2.4305014067102¢-7 Il Drawing Method: c
Nella diapositiva successiva tutti i parametri non vengono Megnfication; (19867770 Qs Chedt: o/
cambiati, I'unico parametro che andremo a cambiare & il valore e ¢
delle Maximum Iterations nella formula tab LY o frretons: B2 3 Y
Skew Angle: 0 v b [ adjust Automatically
Left Top (Re): |-1.47034488699513 1 Starting ... (0.0 ‘
[ arting ... \r.
PER VISUALIZZARE L’ESEMPIO SUL PROGRAMMA APRITE eitToptimy [77szseszeTroees i SR9 (00 W‘
: Exponent: 2.0
FILE®>>NEWFRACTAL->EMOSSED(MANDELBROT) RiohtTon (Re): [”7033475_3893_557 | 2 : - }64 |
- A Right Top (Im): [7.79296323267706e-6 \ S
IN OUTSIDE COLOR LASCIATE "NONE" MA e T Emboss ... [lteration 9
TRANSFER FUNCTION = SQRT Right Bottom (Im): ~ |-7.306862951535022-6 Light An... [0.0 |
IN LOCATION METTETE: et | |
CENTER=(-1.47033482044434, 2.4305014067102€-7)
MAGNIFICATION = 198677.78
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Rimaniamo in tema di Drawing Method e
chiudiamo e riapriamo Ultra Fractal con il
Mandelbrot di base, avremo:

= Drawing Method = Guessing
= Periodicity Checking = Normal
= Additional Precision = 0

= Maximum lterations = 250
Quando apriamo UF il Mandelbrot di base
presenta questo settaggio
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= Adesso nella ToolWindows apriamo la
finestra statistics:

Statistics - Fractall

=

General | Trerations

[ PR TR TR TR R TR TR TR R TR W N N N W T W e e e
Come possiamo vedere FIogKess: HLIRDE
usando un Drawing Elapsed: ‘0:00:00.12
. . Remaining: 0:00:00.00

Method=Guessing a noi ikl ‘

A Y ) Pixels/sec: 2457588.6
sembra che I'immagine sia |
calcolata in modo completo Precision:. Double.

ma non e cosi perchée e s
calcolata all’88.4 % con

2457588.6 milioni di Pixel/sec

Decimals:

01/02/2014 Creato da Andrea Spinozzi
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Adesso invece vediamo come viene calcolata
I'immagine di Mandelbrot cambiando il

= Drawing Method = Multipass

Statistics - Fractall
General |Iteratibns I

|

= Periodicity Checking = off

* PiU lento perché calcola  foess oo
- (y Elapsed: 0:00:00.18
Remaining: 0000 0
meno pixel al sec ma 100%
iy
Calculated:
Inside:

Min. iterations: 2
Max. iterations: 249
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Il tasto “explore” e una funzione molto comoda per
vedere un‘anteprima di come cambiera l'immagine al
cambiamento dei valori di un parametro

Questo e molto utile perché non dobbiamo cambiare i
valori del parametro ed aspettare che il frattale venga

ricalcolato
EXPLORE=
muoverci li

per vedere I'immagine risultante.
Apre una nuova finestra dove possiamo
peramente su tutti i valori del piano

aumentando il RANGE a nostro piacimento
EYEDROPPER=Utilizza i valori della finestra attiva del

frattale, qu
finestra del

indi muovendo il mouse(contagocce) sulla
frattale avremo la nostra anteprima ma

non abbiamo la possibilita di aumentare o diminuire il

range

01/02/2014
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File Edit Fractal Animation Options Window Help

Apriamo un nuovo AR 00 WS 6 o "D ST

frattale da: :
File=>New Fractal g
C a rte”a aS.Ufm Maximum Tterations: e—FP
Selezioniamo 4 |
“3D_Set” | L
Adesso selezioniamo 1
con il mouse(pulsante '|
sx) il"Parameter 1” che —
troviamo in Formula |
Parameters nella - |
formula tab.Appena om 9
clicchiamo nella casella — s/
del parametro si aprira iz |
a destra una piccola  m S|
finestra con due = )
possibilita, I'explore e

I'eyedropper, noi
clicchiamo sull‘explore:

Completed Elapsed: 0:00:00.60
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Mettiamo in alto
asxunrange=2 e
poi muovendoci
con il mouse
sotto al piano
vedremo che
nella finestra a
destra del Fractal
Mode la nostra
immagine
cambiera in base
ai valori che
stiamo scorrendo
con il mouse,
guando siamo
soddisfatti basta
cliccare sul piano
con il tasto
sinistro del
mouse e si aprira
la finestra con
quel valore del
parametro e
rispettiva
immagine

01/02/2014
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Provate lo stesso procedimento ma cliccando
sull’eyedropper e poi andate con il mouse nella
finestra attiva del frattale.

Possiamo selezionare “explore” o “eyedropper”
anche cliccando con il pulsante dx del mouse sul
parametro.Si aprira un menu a tendina con la
possibilita di selezionare i due metodi.

Tutti i parametri sia della formula fractal sia dei
colori sia delle traformazioni hanno queste
funzioni di explore e eyedropper.
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Explore: Il tasto explore apre una nuova
finestra con la possibilita di inserire un
“range” del piano

Eyedropper: Non apre una nuova finestra con
un range ma lavora solo sulla finestra attiva
del frattale, quindi con solo le possibili
coordinate nella finestra attiva

Possiamo dire che Eyedropper e contenuto in
Explore

lo uso quasi sempre |'Explore
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Con il termine “"Switch” intendiamo passare da due set
collegati con un semplice click.

| due set collegati sono Mandelbrot e Julia

Mandelbrot z=z"2+c

= Z=Parametro complesso

= C=Pixel

Julia z=z"2+c

= Z=Pixel

= C=Parametro complesso(seed, semenza)

Non tutte le formule hanno la possibilita dello switch,
dipende dalla struttura della formula

Importante sapere che se inseriamo un colore e cambiamo
parametri al Mandelbrot Mode avremo sempre lo stesso
coIcglre e uguali valori di parametri corrispondenti nel Julia
Mode
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Apriamo sempre il "3D_Set” in as.ufm

In formula tab leggerete “Mandelbrot Mode”
Dalla toolbar selezioniamo il pulsante di Switch, oppure premiamo F7 /=2
Adesso con il mouse andiamo sulla finestra attlva del frattale e vedremo
che al muoverci del mouse un‘immagine sara in anteprima nella finestra di
Fractal Mode

Provate anche a cambiare qualche funzione nella sezione “"Functions” della
formula dopo aver attivato lo switch e vedrete che quando cambia la
funzione cambia anche nello switch cioe nel rispettivo Julia set.

Quando siamo convinti della nostra immagine clicchiamo con il pulsante sx
del mouse

Si aprira un nuovo frattale sempre con la stessa formula ma questa volta in
Fractal Tab sara il Julia Mode, da qui inseriremo colori in outside lavoreremo
conigradients etc..

Possiamo usare lo switch da tutte le formule che hanno un Mandelbrot ed
un Julia corrispondente

Altro esempio, selezioniamo Mandelbrot da standard.ufm e usiamo lo
switch per passare a Julia.

?/
‘.?
|
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Con questa tecnica abbiamo visto come e
semplice passare da un set all‘altro con un
semplice click

Inoltre e utilissimo avere la finestra di
anteprima per non dover aspettare il ricalcolo
dellimmagine ad ogni cambiamento di
valore del parametro

Passare da Mandelbrot a Julia non e mai stato
cosi semplice e divertente

01/02/2014 Creato da Andrea Spinozzi
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Cambiamo i parametri nella
formula tab, lalocation, lo
zoom, fino a quando siamo
soddisfatti della nostra
immagine.

Possiamo fare lo switch al
set di Julia e continuare a
cambiare i parametri in Julia
fino a quando siamo
soddisfatti dell'immagine

7

Lavoriamo con il
gradiente

Scegliamo un
frattale da new

fractal

Ve

frattale, alla fine
realizzeremo la Jpeg

-

*Non abbiamo limitazione
per la creazione del nostro

01/02/2014
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Scegliamo un
algoritmo
colore Outside
o Inside

eCambiamo tutti i parametri
che vogliamo del colore fino a
quando non siamo contenti
della nostraimmagine

gradiente

eCambiare i valori dei
parametri
trasformazione

L avoriamo con il

A
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Ogni layer selezionato in Fractal Properties ha un suo
gradient di riferimento

| layers e i rispettivi gradient possono essere mescolati con
il merge mode nella finestra fractal properties

Quando attiviamo il gradiente, UF permette dalla toolbar
di randomizzare in diversi modi il gradiente

La smooth curve cambia la sfumatura del colore in base
alla linea di interpolazione che unisce i punti di controllo
del gradiente.

Possiamo aggiungere o eliminare i punti di controllo del
gradiente

Possiamo opacizzare il gradiente in ogni punto di
controllo, molto utile per le maschere(vedremo piu avanti)
Possiamo creare i nostri gradienti personalizzati e salvarli
in una cartella apposita
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Possiamo selezionare piu punti di controllo e cambiarli

Insieme:

Teniamo premuto il pulsante sx del mouse e selezioniamo
all'interno del gradiente i punti di controllo che vogliamo

utilizzare
Dal gradiente premiamo il pulsante dx e si aprira una

finestra a tendina con varie funzioni
Sopra la toolbar cliccando sulla scritta “"Gradient” si
aprira un‘altra finestra a tendina dove abbiamo altre

funzioni:
Possiamo invertire un gradient
Randomizzare in diversi modi
Attivare o disattivare la Smooth Curve
Attivare i punti di controllo per opacizzare il gradient
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W Fractal Insert
Delete

o Color Cl4+-F2
Opacity Ctrl+F3 Unido

- £ eric

74 Link Color and Opacity  Crl+L

Q." Select Color. .. Ctrl+Enter
»u® Smooth Curves ** Randomize Color

»7 Evedropper
= Randomize FS i 5

Randomize Bright Fr 74 Link Color and Opacity  Chrl+L

Randomize Misty F7 v Smooth Curves

Randomize Custom... F3

i® Copy Chrl+C
m Adjust Colors,.. Ctrl+] i rocee Cirley

Reverse Duplicate Ctrl+D

Invert Replace... CErl4+R

Menu a tendina attivato premendo il

Dalla Tool ' '
allaToolbar pulsante dx del mouse dal gradient attivo
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Quando inseriamo un colore Outside o Inside, in tutti i
colori avremo:

= Color density=Densita del colore tra i vari punti di
controllo del gradiente

= Transfer Function=Funzione di trasferimento che traduce
un valore di indice moltiplicato per |la desnsita del colore
ad un‘entrata del gradiente

= Solid color=Usa un colore solido, aprire Mandelbrot e
cambiare il solid color in Inside color e vedere I'esempio
VISIVO

* Gradient Offset=Aggiunge una deviazione di posizione al

gradiente ma si puo avere lo stesso risultato roteando il
gradiente stesso.Poco usato.
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Le funzioni della Toolbar

Uno squardo alle Options per i percorsi dei file e commenti
| vari tipi di files (Formule, Colori, Trasformazioni, Plug In,
Gradient, File frattali etc...)

Tutte le finestre relative a Layer Properties, quindi
Formula, Inside Color, Outside Color, Mapping e Location
Abbiamo parlato di Bailout

Abbiamo parlato di massime iterazioni con esempi visivi
Abbiamo visto |I'Explore e I'Eyedropper

Abbiamo parlato di switch

Abbiamo spiegato le funzioni di un gradient

Abbiamo visto le funzioni base di entrata del gradient,
transfer function, color density etc...
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= MANCANO ANCORA TANTISSIME COSE

= Non allarmiamoci abbiamo comunque fatto un
passo avanti ma il bello di UF e che e veramente
un programma INFINITO e non si finisce mai di
Imparare
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Daremo uno squardo piu approfondito alla
ToolWindows

Approfondiremo la Toolbar e le opzioni di
Render to Disk

Vedremo l'unione di piu layers
ntrodurremo le maschere

ntrodurremo i gruppi
Daremo uno squardo alle formule Plug In

Creeremo delle immagini con dei tutorial

[2014 Creato da Andrea Spinozzi
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Non entreremo nella matematica dell’Editor

= Non vedremo come creare una nostra formula
frattale o colore o altro, ma basta che sappiate
che possiamo farlo se vogliamo

Non parleremo delle animazioni per il
momento

Non parleremo delle connessioni Network ad
un computer remoto per velocizzare il calcolo
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Abbiamo detto che non ci inoltreremo
nell’'editor del programma e NON SERVE
SAPERE MATEMATICA PER FARE FRATTALI
pero e bene sapere che tipo di formule
esistono e cosa permettono di fare

A noi non interessa come e scritto il codice
nero ci interessa sapere COSA CI PERMETTE
DI FARE QUEL CODICE

Piu avanti daremo uno squardo alle varie
tipologie di formule
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Abbiamo gia visto
cosa possiamo fare
dalla finestra di
layer Properties

Abbiamo parlato di
merge mode in
Fractal Properties
ma approfondiremo

| Layer Properties - Fractall, Backeround

ctal Properties - Fractall

Fractal Mode - Fractall

Abbiamo visto
che Fractal
Mode crea le
anteprime ma
approfondiremo

01/02/2014

| Compiler Messages
| Render to Disk
| Color Cycling - Fractall

| Statistics - Fractall

Abbiamo visto cosa possiamo
vedere dalle statistiche ma

Creato da Andrea Spinozzi approfondlremo
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Qui a fianco la
spiegazione delle
funzioni presenti
nella finestra layers
di FRACTAL
PROPIERTIES,
come vediamo
merge mode e
opacizza il layer
sono disattivati
perché abbiamo
selezionato il layer
MasklInside(usato
come maschera) se
selezioniamo un
altro layer si
attiveranno.

01/02/2014

ra:tal,r.:ll:leris - racal '
Lavers Image tﬂ'is.i:'or':r‘ICdmmenfs" s

m I_—j_l InsideQrbitTraps

Merge mode

—P Opacizza il layer

0%

+

P Aggiunge un layer

Elimina un layer

- Aggiunge un gruppo

el Usa il layer come maschera
d per il successivo layer o gruppo

0, o

Mostra solo la maschera
deattivando gli altri layer

Attiva o deattiva le opacita,
trasparenze se sono presenti nel
layer

Attiva o
disattiva
layer

La lente indica quali layer vengono zoomati

se é deselezionata e zoomiamo l'immagine tutti gli altri
layer saranno zoomati ma il layer con la lente deselezionata
rimarra fisso e non verra zoomato.
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- TOOWING

PROPIERTIES avremo le corrispettive formula frattale,
colore, mapping e location in LAYER PROPERTIES per
quel determinato layer selezionato, ugualmente per il
gradiente.

La finestra IMAGE in FRACTAL PROPERTIES determina la
dimensione dell'immagine, la risoluzione ed il valore
gamma.

La finestra HYSTORY permettete di vedere tutti "l
PASSAGGI” che abbiamo fatto all’apertura dell'immagine,
possiamo tornare indietro o avanti anche dalla Hystory.
La finsetra COMMENTS visualizza I'Autore e i commenti
che abbiamo inserito nelle "Options—>Default”.Aggiunge i
copyright o resetta i commenti.
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Fractal Mode - Fractall

——3P Zoom in i layers
selezionati consiglio di
tenere sempre attiva

b K ~/\\ Zoom out i layers

selezionati
Da notare che abbiamo attivato la \ \ o N o i e
n va Modo normale YOp 1 AR zoom basta fare doppio
lente zoom nel layer *Zoom attivo st SR oo mlsamp i

Apre la finestra "seleziona

mentre nel layer "Fermo” e

deselezionata ed in Fractal Mode st oot s
abbiamo |'anteprima di quello che
andremo a zoomare ma anche del
layer che rimarra fermo...MOLTO
UTILE
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Mostra |I'anteprima di quello che stiamo facendo,
I'anteprima dello switch o delle funzioni explore
eyedropper etc...

Permette di selezionare zoom in e out e con la "V” di
avviare lo zoom ma possiamo zoomare anche con
doppio click dalla finestra frattale

Permette di “crop” I'immagine poi "V” per attivare
Seleziona lo switch

Apre il select mode ma si puo aprire il select mode
anche con il mouse dalla finestra frattale, tenendo
premuto il tasto sx sul mouse muovendolo per creare
il select mode
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Abbiana le dimensioni del select
mode della finestra frattale con
I'anteprima e mantiene |'aspetto

Effettua lo Stretch orizzontale o
verticale sul frattale

Per vedere come lavorano queste due icone fare i sequenti passi:

1. Aprire con il mouse o cliccando l'icona nella finestra fractal mode il “Select Mode”
2. Adesso clicchiamo una delle due icone
Dalla finestra frattale ci sara il quadrato del select mode, bene posizionarsi con il mouse
sulle linee orizzonali o verticali
4. TENERE PREMUTO CTRL E MUOVERE IL MOUSE A DESTRA O SINISTRA O SU E GIU'
5. RIPETERELO STESSO PROCEDIMENTO CON L'ALTRA ICONA
Queste due icone lavorano solamente se dalla finestra frattale teniamo premuto CTRL e poi ci
muoviamo con il mouse altrimenti UF lavora in default, io consiglio di tenere attiva la lente di
zoom in e l'icona a fianco
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Questa tool permette di
connettersi ad un
server(UltraFractal Server) per
velocizzare il calcolo di immagini
molto complesse e lunghe da
calcolare, tipo con zoom molto
profondi(UF pud zoomare fino a
10”4000) quindi con maggior
tempo diresa.

In questo modo, connettendosi al
server, si puo velocizzare il tempo
di calcolo.
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| Network

Skatus:

Time:

Pixels/sec:

—gp Aggiunge

connessione
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In questa finestra vengono
visualizzati gli errori di
compilazione o i messaggi di
giusta compilazione della formula
sia frattale che colore o
trasformazione.

Le tre icone a dx sono usate
rispettivamente quando si sta
scrivendo una formula e viene
rilevato un errore.

La primaicona con la freccia el
documento apre l'editor alla linea
di errore nel codice.

Il punto interrogativo apre
direttamente I'help di UF per quel
relativo errore.

Il cestino elimina i messaggi.

€ Successfully compiled 'as-3D_Set' in 'Documentiil
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In questa finestra vedremo lo stato

di avanzamento della nostra
immagine mentre la stiamo

letteralmente, rendendo sul disco

in Jpeg, Tiff, Avi, etc...

NB:Da questa finestra se
premiamo la rotellina
dell'ingranaggio con il "+”, UF ci
aprira il browse dei parametri
salvati quindi non rendera
Iimmagine che stiamo facendo
ma aprira il browse dei file .UPR.
Per rendere al disco I'immagine
aperta nel programma basta
cliccare dal menu sopra la toolbar
la scritta FRACTAL->RENDERTO
DISK
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| Render to Disk

I T

Status:

Elapsed;
Remaining:
Pixels/sec:
Source:

Destination:

| Render to Disk

250306 TmanRainbow133
+
& 4
o
[@ Je
Status: Calculating {2.11%)
Elapsed: 0:00:19.65

Remaining:  0:15:12,99

Pixelsfsec:  687.93

Source: C:\Documents ...1250306TmanRainbow] , ufr
Destination:  Documentil.. 1250306 TmanRainbow1 33.jpg
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Quando abbiamo finito di fare la nostra
immagine e la vogliamo mettere in Jpeg per
stamparla o in altro file abbiamo detto che
apriremo l'immagine salvata con file>open
poi dal menu sopra la toolbar clicchiamo su
fractal>render to disk

Si aprira la finestra delle opzioni di render...
Diapositiva successiva
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Sceglieremo la cartella di
destinazione della nostra immagine
ed il formato dell'immagine.

Render ‘250306 T manRainbow1' to Disk

~Destination

' 3 Destination File: DocumentiiUltra Fractal SImages|250306TmanRainbow1 . jpg =
Abbiamo detto che UF permette di | =

L] L] . . . fl ' p H *.- ..
rendere in diversi formati ed anche in Fe ot FEG mode L k) £
.AVI per le animazioni ma noi ci 5T . ~Anti-aliasing

soffermeremo §ul .rendere in Jpeg, Width: — — | | Anti-aliesing: |Custom: ]
per le altre opzioni basta che date : - — (e 19

g i Height: g0 I Threshold:  [0.05 IS
uno sguardo.Noi dobbiamo parlare e el e rit e 1 &
0 Se original aspect ratio =] H
invece delle ANTI ALIASING. | : L
Quindi scegliamo la lunghezza e Resoltion: [46.500 19 [pixelsjcm 19 | | subdvisons:  [53x3) )

I'altezza dell'immagine con Width e [ JRender portion [ Split into tiles

~Options
HEIg htl la risol uzione, possiamo Estimated space per folder: 1.1 MB Force Linear drawing method
rendere anche solamente una Available in system Folder: 10693.0 MB []Generate log file
porzione dell'imma gine o diversi Available in destination Folder: 10693.0 MB Open when finished

ritagli.Nelle Options consiglio di
lasciare force linear drawing method,
per il motivo che abbiamo visto
all'inizio e cioe che e il piU accurato
metodo di calcolo(one-pass linear) e
open when finished.
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L'anti-aliasing aumenta il tempo di calcolo ma
migliora di molto l'immagine finale

Smussa gli angoli frastagliati dell'immagine e la rende
piu lineare

Ci sono diversi modi in UF per creare anti-aliasing:
= Off(no anti aliasing)

Quick(veloce anti aliasing)

= Normal(normale)

= Non adaptive

= Custom
Consiglio di usare custom in un valore di threshold tra
il non-adaptive e normal.
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Color Cycling permette di scegliere una velocita di
movimento poi cliccando sulle frecce destra o
sinistra rotea il gradiente verso destra o verso
sinistra con la velocita settata.Consiglio di aprire il
gradiente e provare cliccando sulle frecce e vedere
come si muove il gradiente e cambia I'immagine.E
comodo per le animazioni.

Color Cycling - Fractall

01/02/2014 Creato da Andrea Spinozzi
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| Statistics - Fractall

- General
Progress: 100.0% a
Elapsed: 0:00:11.71 i
Remaining: 0:00:00.00 1
Pixels/sec: 26216.1 |

Precision: Double
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Abbiamo visto che nella tool statistics nella
finestra GENERAL possiamo vedere:

Il tempo di calcolo del layer selezionato
Quanti pixel al sec vengono calcolati

Se il layer e calcolato al 100% in base al
drawing method e periodicity

Le finestre general e iterations in statistics
sono riferite al “layer” attivo non a tutta
I'immagine ma layer per layer
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2/201

Nella finestra ITERATIONS abbiamo un
grafico delle iterazioni

Mettere su LOG

Piu il grafico e lineare e ben distribuito piu
siamo sicuri di usare il giusto valore di
iterazioni

Possiamo anche cliccare au ADJUST
AUTOMATICALLY in LAYER PROPERTIES
anche se meno professionale

A Creato da Andrea Spinozzi




File Edit Fractal &nimation Options Window Help

= Fino ad ora abbiamo visto alcune delle principali funzioni della
toolbar, quali:

= Nuovo Frattale

= Aprifile

= Salvafile

= Le due icone Undo Redo(il redo e infinito)

= Ledueicone FRACTAL E GRADIENT e come si comporta la toolbar
= Letre icone relative alla finestra Fractal Mode

= Salva parametri

= Render to disk(o dal menu Fractal=>Render)

= Help o premere F1
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File Edit Fractal A&nimation Options Window Help

* Browse=Apre il browse deifiles, .upr, .ufm, .ucl, etc..

*Copy=Copia il codice; se attiviamo il tasto “gradient” dalla toolbar, quindi
attiviamo le funzioni del gradient anche nella toolbar e poi premiamo copy,
la funzione copiera il "gradient”, se invece teniamo attivo il tasto fractal, la
funzione “copy” copiera il codice del frattale che potremo incollare in
qualsiasi programma di “word” o in UF anche andando da Edit->Paste, in
questo modo si condividono anche i parametri nella lista di UF, cioe
copiando il codice del frattale(tenendo attiva la casella fractal nella toolbar)
e poi incollando con il tasto destro del mouse il codice nella e.mail
*Paste=Incolla il codice copiato
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Browsing - Examples.upr

Location: Pocumenti\,UItra Fractal S\Parameters\Examples.upr

23 Nerovision

23 playerform

Cars

23 Setup Programmi

23 shpongle MP3

23 Ultra Fractal 4

B3] Ultra Fractal 5

£ 2003

£ 2012

£ 2013

3 challenge

3 Formulas

£ Fractals

1 Gradients

3 Help on Formulas

£ Images

B3] Parameters
£ 201304

[y 201305.upr

@ Examples.upr
m Layer Examples.upr
: m My Fractals.upr
(] videoBTMP

m Animation Examples,upr

Black and Tan F.

Default

BlackAndTanFantasy {
fractal:

credits="Kerry Mitchell;8f2/2002"
layer:

mapping:

formula:

title="Black and Tan Fantasy" width=480 height=480 layers=5

method=multipass caption="Layer 5" opacity=100 mergemode=screen
center=0/0 magn=2,28571428571428571428571428571429

maxiter=1000 percheck=off filename="Standard.ufm" entry="Newton" p_p1=4/0

01/02/2014

Creato da Andrea Spinozzi

2| Parameter Files ) %

Dalla Toolbar, nel cerchietto in
rosso, possiamo selezionare che
file visualizzare nella finestra di
"Browsing"” poi entreremo nelle
cartelle corrispondenti, abbiamo
anche la funzione “Find
Entries”(lente di ingrandimento)
in questo modo si aprira una
nuova finestra diricerca
avanzata dove mettere i dati piu
significativi della ricerca peri
files e dove effettuare la ricerca.

73



Abbiamo visto le maggiori e piu importanti
funzioni della toolbar per la creazione di
un‘immagine, rimane da dare un‘occhiata al
menu “Windows"” e "Help” che potete vedere
da soli.

Dal Menu c’e anche I""Animation” che pero
non tratteremo in questa spiegazione
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Diamo uno squardo alle maschere ed ai
gruppi per poi passare a dei tutorial

UF permette di mascherare i layers in diversi
modi

Possiamo mascherare anche un gruppo
UF5.0 permette anche di RAGGRUPPARE
ayers(tasto “"New Group” in fractal
oroperties) e poi usare il gruppo
mescolandolo con un merge mode.
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Una maschera e un layer che usa delle aree
trasparenti nel gradiente che permettono di
mascherare il [ayer successivo in suddette

aree
Esempio sequite passo passo:

Andate in FILE->NEW FRACTAL ed aprite
MANDELBROT nella cartella standard.ufm
Aggiungete un layer dalla fractal properties
windows ed attivate il gradiente dalla toolbar
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Una volta che avete il gradiente attivato nella
toolbar, dalla finestra del gradiente aprite
"SHOW OPACITY" e nella toolbar cliccate
sull’icona “Link Color and Opacity”

Dalla finestra Fractal Properties deattivate il
ayer background e rimanete in selezione su
ayer 1

Dovreste adesso avere una situazione di
questo tipo sul programma:
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@ j Ultra Fractal
File Edit Gradient Options Window Help

Fractal1

Mandelbrot

Drawing Method: C'”
Periodicity Checking: Qf
Additional Precision: :B ?
Maximurm Iterations: _ 4

[ adjust Automatically

Starting ... KU I
Starting ... [0 |
Power (... lz |
Power (L., [0 |
Baiout v... |4 |

Layer 1 e blu quindi attivato

Fractal Propertles Fn. tal1

_______________ - “Layers 1 Image T History

—
Normal v

--------------- 3 yate il baf:kground e rimanete
1 selezionato

[ Fractal N\ode Fractal‘l

Rokation: ; 2 Hue: B
Position: |0 E Green: |0 g Saturation:  |255 2

o a . o -
Opacity:  |255 Blue: 133 Luminance:

1 control point(s) selected | B Fractalt
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Addesso rendiamo trasparente un’area
dellimmagine sul gradiente

Dal gradiente selezionate il PRIMO PUNTO DI
CONTROLLO DA SX, quello riferito al BLU
Dalla sezione di OPACITY trascinate in basso il
punto di controllo numero 1 quello del blu
Cliccate sul secondo punto di controllo dalla
sezione OPACITY e spostatelo verso sx fino alla
posizione 8
Ricliccate sul punto di controllo 1 e spostatelo a
dx fino alla posizione 7

Vedere finestra successiva:
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Hue:
Green: Saturation:

Luminance:
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tall, Layer 1

Location | Mapping | Inside | Outside

g
Mandelbrot &
A e S . N
Periodicity Checking: ~ [vormal 9] p#

AddtonalPrecison: 0 |V ?
Maximum Iterations: _; <

[ adjust Automatically
Starting... [0 |
Starting .. [0 |
Poweer (.. |2 |

Ecco l'area
trasparente

(omd 19 [0 6 S E———

Ecco l'area

l—Posi!ion_evBrdel
i

3 Ratation: Ed: -
Positiunc =5 Green: f; Saturation:
Opacity: 255 Blue: |245 & Luminance: (250 =
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Adesso cliccate sul background layer in modo che si attivi ed

Ultra Fractal EEX

&
avrete - File Edit Fractal Animation Options Window Help
L]

= % = | e 6 |[m m

y | Location IMapping Formula |Inside IOutside l

Mandelbrot

]
® ] Fractal1

Drawing Method:
Periodicity Checking:
Additional Precision:

Maximurn Iterations:

Layers ‘Image iHistory iComments I
Normal E LN lm
Js
o8RO 1E| iagert o

l e - Fractall

Rotation: Red: _; Hue:

Pasition: EE Green: _; Saturation:  |255
ity I:] Blue: Luminance: m

Completed X:-25 ¥:-132 Elapsed: 0:00:00.04

N
&
=1
l

<[

n
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= Ora cliccate e tenete premuto sul layera e

spostatelo in basso al posto del layer
background ed ATTIVATE USE AS A MASK...
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File Edit Fractal Animation Options Window Help

= o= & e a9 2 : Layer 1
: Locaton | Mapping | Formus | inside | Outside |

Mandelbrot &
Drawing Method: _Guessing 5 (&
Periodicity Checking: @f
2

D 4

]
® Fractal1

Additional Precision:

Maximum Iterations: 100

[ adjust Automatically

Starting ... IIJ

Starting ... 10

Power (... |2

Power (L., IU

Bailout v... |4

l § \‘ f
R0 1- Background

| =oCT—

‘Grauient - rraciail, Layer | i Iaye[ 1al posto
| 1
nd e

rm: cona della
a

(Disabled because mask layers only use the opacity part of the gradient)

Completed Xi 34 ¥:-136  Elapsed: 0:00:00.04 = ; [) Gradient - Fra...
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= Adesso attivate il gradiente della maschera se

non lo &, dal menu Gradient cliccate su
“INVERT".....DIAPOSITIVA SUCCESSIVA.
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Options  Window Help

= W Fractal F4

Color Ctrl+F2
! Opacity Chrl+F3

74 Link Color and Opacity  Ctrl+L

Smooth Curves

= Randomize
Randomize Bright
Randomize Misty
Randomize Custom,..

@ Adjust Colors... Ctrl+3
Reverse
Invert

Ultra Fractal

Fractall

Gradient - Fractall, Layer 1

Location | Mapping = Formula | Inside | Outside

Mandelbrot (628
DravingMethod:  [ouessng 9]
Periodicity Checking: @f

Additional Precision:

Maximum Iterations:

["] adjust Automatically

Starting .. [0 |
Starting .. |0  |=
Power (... |2 |
Power (L., [0 |
Baloutv... |4 |

{Disabled because mask layers only use the opacity part of the gradient)

al Properties

“Layers |Image | History | Comments

| = J 0%
() g B - Background
LM

Contains commands for manipulating the gradient.

01/02/2014
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File Edit Gradient Options Window Help

B = 5 = .k BR | w = . g Layer Properties - Fractall, Layer

= Location TMapping Formula ™ ilnside Toutside 1

Mandelbrot &

Drawing Method: (G

Periodicity Checking: {}?
?
b 4

I Fractall

Additional Precision:

Maximum Iterations: 100

[l Adjust Automatically

Starting ... [0 |
Starting ... |0 |
Power (... 12 |
Power (L., IU |
Baiout v... |4 |

ropert ractall

ayers ‘;nage TW

(WECH = !- Background |

Layer 1

o
o
=

Gradient - Fractall, Layer 1 n
[d

(Disabled because mask layers only use the opacity part of the gradient)

actal Mode - Fractall

> Hue/Saturation/Luminance
-

4 control point(s; | [ Fractalt
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E importante fare una precisazione, abbiamo visto come creare e mascherare un
layer partendo dal gradiente, ovviamente, il colore &€ mescolato in base alla funzione
di “transfer function” nell'outside o inside tab del colore, in base all'area nella quale
stiamo lavorando, quindi quando creiamo una maschera la stiamo creando anche in
base alla funzione di trasferimento del colore e alla densita usata.

Noi abbiamo usato un outside color NONE ma se cambiamo la transfer function o

il color density nell’'outside tab del colore(in questo caso NONE) vedrete che
ovviamente cambia anche la maschera, perché la funzione di trasferimento abbiamo
detto che traduce un valore diindice all'interno del gradiente quindi cambiando la
funzione ovviamente cambia il modo in cui quel gradiente in generale viene
calcolato.

Le maschere quindi sono utili per definire aree di lavoro e creare effetti separati e
con diversi patterns o metodologie.Nell'area trasperente noi possiamo inserire
quello che vogliamo anche un‘altra formula con un altro colore, una foto, tutto
quello che vogliamo.
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Altro esempio di maschere:

Apriamo file=>New fractal->Mandelbrot (da standard.ufm)
Duplichiamo il layer in modo da avere due layers come prima
Nel layer BACKGROUD clicchiamo sull’inside color in Layer
Properties e sul solid color nella formula tab.

Mettiamo l‘opacita a zero

Sempre nel layer background clicchiamo sull’icona per

mascherare.
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& Ultra Fractal
File Edit Fractal Animation Options Window Help

"Location | Mapping | Formula | Tnside”| Outside |

{None)
Color Density:
Transfer Function:
Fractal] Solid Color:
Gradient Offset:

Repeat Gradient

ractal Prope ractall

Lavers_] Image THistoirx_yVT Comments |

|
-Layerl D,

Background

B
Completed Xi -10 ¥: -49 Elapsed: 0:00:00.04
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Abbiamo mascherato ma questa volta usando il
solid color dell'area interna, cioe quella
convergente dell'immagine, ovviamente
questo non e sempre possibile, perche se
I'immagine non ha due aree, una convergente
ed una divergente, quindi un outside ed un
inside, non possiamo farlo.
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Permette di raggruppare i layers

Un gruppo ha un "merge mode” globale che puo essere mescolato
con altri layers dell'immagine

Oltre che un merge mode globale ha anche la funzione di “pass
through” cioe in default in questo caso I'immagine e definita dal
merge dei layers del gruppo uno per uno.

Puo essere usato per diverse funzioni o schemi per I'immagine

Ha la possibilita di essere opacizzato come i layers

Un gruppo puo avere una maschera, in questo caso la mashera
lavora suTUTTI i layers del gruppo(molto comodo, non era
possibile nelle versioni precedenti ma bisognava creare ogni volta
la stessa maschera per layers diversi)

Puo essere spostato sopra o sotto come con i layers

Per inserire i layers nel gruppo creare un gruppo dalla finestra
fractal properties e spostare il layer che si vuole inserire nel gruppo
, cliccando e tenendo premuto sul layer e inserendolo nel gruppo.
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Facciamo un esempio di come lavora un
gruppo e dei merge mode

E importante che mi sequiate passo passo
con le spiegazioni e le slide per vedere come
funzionano anche i merge mode

Creeremo un‘immagine con tre layers

Due layers in un gruppo ed un layer di
backgroud

Aprite file=>New Fractal->Mandelbrot (come
prima)
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Adesso aggiungete un layer ed inserite un outside colorin
standard.ucl “Orbit Traps”

Mettete la transfer function="CubeRoot” e la Trap
Shape=Ring

Nella formula tab di layer properties di layer 1 mettete il
bailout a 64, il drawing method=multipass,periodicity
checking=off e maximum iterations=250

Create un gruppo con il pulsante nella finestra fractal
properties

Inserite il layer 1 nel gruppo

Vediamo nella diapositiva successiva cosa abbiamo fatto
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‘Location | Mapping
Mandelbrot

Drawing Method:

Periodicity Checking:

Additional Precision:

a1 Inside | Outside

Multi-pass Linear v

Off

Maximum Iterations: Z .
["] adjust Automatically

Starting ... |0

Starting ... |0

Power (... 12

Power (I... ]D

Bailout v... |64

01/02/2014

File Edit Fractal Animation Options Window Help

B o= & & w

Fractall

_ ¥i-83  Elapsed: 0:00:00.35

Creato da Andrea Spinozzi

"Location TMapping T Formula T Inside =

Orbit Traps
Color Density:
Transfer Function:
Solid Color:

Gradient Offset:

L____Mc
oo 19
I °

[V]Repeat Gradient

Trap Sh... lring

Diameter: Il.O

Trap Col... Eistance

Trap Mo... [closest

Thresh... [0.25




Adesso clicchiamo sul layer 1(layer dentro il gruppo)

Duplichiamo il layer 1 dentro il gruppo e creiamo un layer 2
identico

Cambiamo la trap shape nel color outside del layer 2 e mettiamo
trap shape = box

Apriamo il gradiente e clicchiamo con il pulsante destro del mouse
sul gradiente di layer 2 si aprira il menu a tendina e togliamo le
"SMOOTH CURVES”

Dal menu->Gradient clicchiamo su INVERT in modo da invertire il
gradiente di layer 2

Togliamo le “smoth curves” anche nel gradiente di layer 1 ma non
lo invertiamo

Quindi clicchiamo sul layer 1 dalla finestra fractal properties e dal
gradiente togliamo le smooth curves

A questo punto avremo....

01/02/2014 Creato da Andrea Spinozzi 96



&
File Edit Gradient Options

4 control point{s)

¢ & | v ul| e

Fractall

Color Density:

Transfer Function:

&

CubeRoot 5 s
?

Solid Color: l:] ?
Gradient Offset: m A
Repeat Gradient
Trap Sh... [box ﬂ
Diameter: Il I
Trap Col... ldistance M
Trap Mo... [closest M
Thresh... [0.25 |
~ Options
Trap Ce... ID ‘
Trap Ce... IO J
Aspect ... Il I
Rotation: 0.0 ]
[ Juse salid Color

Fractal Properties - Fractall

PO Yimecs | ritory Jcommerts ]

Normal v

S ——
RER il

WEcml - <

) g | I Layer 1

Fractall

J Fractall

mgn;v (] Group 1

Layer 2
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A questo punto parliamo dei merge mode

Lasciando il merge mode a "normal”...IL LAYER NON
VIENE MESCOLATO CON QUELLO PRECEDENTE A
MENO CHE NON OPACIZIAMO IL LAYER MA SE
L'OPACITA'E' 200% IL LAYER NON VIENE
MESCOLATO

Per vedere questo, cambiate il merge mode di layer 2
ma lasciate il layer 1 in merge mode = normal e dal
layer di backgroud provate a muovere il gradiente,
attivate il gradiente di background e spostate la
rotazione del gradiente

Vedrete che I'immagine non cambia
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Se invece mettiamo il layer del gruppo = normal I'immagine verra
mescolata tralasciando il backgroud(ovviamente) pero il layer 1
sara mescolato con il layer 2 in base al merge mode del layer 2
Pass trough invece abbiamo detto che mescola la maschera con i
merge mode usati dai layer uno per uno

Se invece cambiamo i merge mode del gruppo UF creera un nuovo
effetto mescolando anche con il layer backgroud

Nella diapositiva successiva ho messo i merge

Layer1 merge mode=Screen

Layer2 merge mode=Luminance

Group Layer merge mode=Pass trough

PROVATE A CAMBIARE | MERGE MA ANCHE IL GRADIENTE
PROVATE ANCHE AD ATTIVARE LA FINESTRA DI COLOR
CYCLING E CLICCATE SULLE FRECCE
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Ultra Fractal
File Edit Fractal Animation Options Window Help

Orbit Traps

Color Density:

Transfer Function: CubeRoot ‘

Repeat Gradient
Trap Sh... [box M
Diameter: | 1 l
Trap Col... Ldistance M
Trap Mo... Lclosest M
Thresh... |0.25 |
~ Options .
TrapCe... |0 ]
Trap Ce... iO I
Aspect ... [1 I
Rotation:  |0.0 |
[ Juse Solid Colar

Fractal Properties - ESEMPIOGRUPPIT i E

'r'l;éversj Imgge?THistory [COjnments ]
Tiee
ERO > & cow: o
LI 7
T | []Q\‘ Layerl r:l—

R TRTaS A& Background =
Opacity
& /——\Eation: Red: Hue:
o [ o | L = -~ I
B =3 =

Completed Xi 1 i -93 Elapsed: 0:00:00.24 | Gradient - ES...
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Abbiamo visto come creare maschere e
gruppi, nei tutorial vedremo meglio queste
opzioni ed anche come lavorare con i
gradienti

Nei tutorial creeremo maschere e gruppi in
modo piu ESCLUSIVO

Poi daremo uno squardo alle principali
formule
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= Aprire da file=>new fractal=> AngelJulia-J che trovate nella cartella AS.UFM e nella formula
mettete

= Bailout=64
= Seedvalue = (-1.475, 0.5) INVARIATO
= Parameteri=(1.7, 0.0)

= Nella location tab di layer properties mettete:
= Center=(-0.3, 0.0)
= Magnification = 1.4
= Rotation angle =-90

= Nell'outside colorinserite DOODADS Il che trovate nella cartella TMA.UCL
= Mettete transfer function = Cuberoot

= Nella formulaTab di Doodads Il mettete TRAP MODE=6

= Dafractal properties cambiate la size dell'immagine in
= Width=800
= Height=500

= ADESSO CAMBIAMO IL GRADIENTE, APRITE IL GRADIENTE E DEVE DIVENTARE COME LA
DIAPOSITIVA SUCCESSIVA
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4 punti di controllo:
Primo punto:
tutto bianco posizione=0

Secondo punto:
posizione=86
Red=255
Green=188 T :
Blue=157

Hue/Saturation/Luminance
Opacity

Terzo punto:
tutto nero posizione=122

Rotation: - -
Position: |36 g Green: >_1—88 g Saturation: |255

Quarto punto:
tutto nero posizione=399

>

Comments

TOGLIETE LE SMOOTH CURVE, L'IMMAGINE
FINALE E’ QUINDI DIAPOSITIVA SUCCESSIVA
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—— ==
ad Operato... (5 ’v’
Operato... (1 Vv’
SeedVal.., |-1.475 }
SeedVal... (0.5 |
Paramet... 1.7 ‘
» V]
Fractal Properties - Fractall PE
Layers f Image ]History I Comments |
Width: 500 v I
pixels v
Height: 500 v
[“IMaintain aspect ratio
Resolution: @DD 'v] [pixels {inch !v]'
Memory allocated: 2.80 MB
Fractal Mode - Fractall D
&)
Compiler Messages )
Render to Disk =8
o
i
I ]
S AR T ] g
]
1 control point(s) selected Color Fractall @uumm
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Il layer di prima lo rinominiamo “Spirale1” ed aggiungiamo
un altro layera apriamo il gradiente del nuovo layer1 e
cambiamo la posizione del secondo punto di controllo
mettendolo tutto bianco in posizione =100.

Adesso tra questo punto di controllo ed il terzo punto di
controllo aggiungiamo un altro punto di controllo con :

= Posizione=113

= Red=193

= Green=111

= Blue=0

Rinominiamo questo layer1 in Spirale2 e mettiamo merge

mode=screen
Diapositiva successiva
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File Edit Fractal Animation Options ‘Window Help

oo Hue/Saturation/Luminance
pacity

‘
| Rotation: [0 g Red: |[193 EE Hue: ES g
Position: ll_é_g Green: —I_I—I—EE Saturation: 255
C] Blue: |0 Luminance: ES

3 Commerts
=L

Hue/Saturation/Luminance

Completed X330 i -147 Elapsed: 0:00:04.34

g n
Init Ope... (s ¥
Operato... [s ™
Operato... [1 'ﬂ

Seed Val.., |-1.475 \

Seed Val... ED.S

Paramet...

Fractal Properties - Fractall ¥
'Layers TImage History IComments 1

BRR S ooy

1.7

or - T
E Q - Spiralel o
=

[Fract o Fractat T
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Adesso creiamo un nuovo layer duplicando spirale2 e lo
chiamiamo MaskSpirale

Apriamo il gradiente di MaskSpirale, apriamo la sezione opacity
del gradiente con Show Opacity, attiviamo i punti di controllo nella
sezione opacita cliccando dalla toolbar "LINK COLOR OPACITY" e
dalla sezione opacity teniamo premuto sul quarto punto di
controllo quello con posizione=122 e lo opacizziamo tutto con
opacity=0, tenendolo sempre in posizione=122

Il terzo punto di controllo sempre dalla sezione opacity lo
mettiamo a posizione 121 cioe un po’ prima del quarto punto di
controllo.

Opacizziamo anche il quinto punto di controllo mettendolo ad
opacity=0 e posizione =399

Merge Mode lasciamolo= Normal in questo layer MaskSpirale, non
ha senso cambiare il merge mode perché e una maschera.

Il gradiente deve diventare cosi:
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Rotation: Red: Hue:
Position: 122 : Green: Saturation:
Opacity: Blue: _% Luminance:
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Nella finestra soprai layer spirale1 e
spirale2 sono disattivati quindi vedete lo
sfondo bianco da voi sara nero ma appena
disattivate i layer diventera come la

finestra di sopra...Comunque tenete tutti i
layer ATTIVI. "
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Adesso rimanendo sul layer MaskSpirale
creiamo un gruppo dall’icona della Fractal
Properties e lo chiamiamo “GroupSpirale”
Clicchiamo sul layer MaskSpirale e dalla fractal
windows clicchiamo su USE AS MASK

In poche parole mascheriamo il gruppo
Adesso prendiamo prima il layer spirale2 e lo
inseriamo nel gruppo

Facciamo lo stesso con il layer spiralex

NON CAMBIAMO | MERGE MODE
L'immagine sara come la diapositiva successiva
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Adesso clicchiamo sul layer Spirale2 e
clicchiamo un Add layer nella fractal
properties avremo un nuovo layeri che
rinominiamo TextureSpirale

Dall'Outside color DOODADS Il scendete con
la scroll bar nella formula tab fino a trovare la
sezione EXTRATEXTURES ed nel parametro
RANDOM mettete Random=2
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Rotation: Red: f,‘ Hue:
Position: _ Green: Saturation:
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Usate il gradiente nella mia cartella che avete
scaricato dal mio sito con i gradients del tutorial, ci
sono anche i gradients di layer Spirale1 e 2 ma
volevo farvi vedere come inserire i punti di controllo
e le opacity, comunque trovate tutti i gradients nella
cartella.
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Quindi abbiamo una maschera
“"MaskSpirale”, layer Spiralex, layer Spirale2,
layer Texture Spirale, e il Group Spirale

Il layer spirale 1 mettete merge mode=normal
(ovviamente essendo il layer di base non ha
senso cambiare merge non serve a niente)
Layer spirale2 merge mode=Screen

Layer Texture Spirale merge mode=Addiction

Nel layer Texture Spirale mettete anche opacity a
60% dalla finestra fractal properties
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Adesso cliccate sul layer Spirale2 e aggiungete
un layeri rinominatelo "Modlter Spirale” e
spostatelo sopra il layer Texture Spirale”

Dalla formula tab di DOODADS I, all'inizio dove
c'e scritto COLORING aprite il menu a tendina e

mettete co

oring=Modulated Iter

Mettete l'opacita del layer Modlter Spirale dalla

finestra Fra

ctal Properties a 75%

Merge moc

e di layer Modlter Spirale=HUE

Aprite il gradiente e lo rimpiazzate con quello

che trovate

nella mia cartella dei gradients

scaricata dal mio sito...Cioe
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Abbiamo finito la spirale ed abbiamo messo tutto dentro un gruppo

NB:I gruppi in UF sono importanti e devono avere delle LOGICHE, si

vedono delle immagini con dei gruppi che non hanno ragione di

esistere, il gruppo deve creare un tool per I'immagine altrimenti si

puo omettere

In questo caso il gruppo e importante altrimenti avremmo dovuto

Llnettere una maschera per ogni layer(come nelle versioni precedenti
| UF)

Inoltre ci serve anche a dividere la spirale dallo sfondo che andremo

a colorare fra poco

In questo modo il nostro file e molto ORDINATO.

Pero per esempio non stiamo utilizzando la funzione di merge mode

del gruppo perche non abbiamo messo nulla prima della maschera

del gruppo

Se volete vedere aggiungete un layer prima di MaskSpirale e

cambiate i merge mode del gruppo, in questo modo userete anche il

merge del gruppo
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Adesso facciamo la parte di sfondo della nostra immagine.
Ci serve una maschera per creare lo sfondo che non interferisca nella nostra spirale.
Se clicchiamo su MaskSpirale e aﬂgiungiamo un layer da li, UF mette un‘altra maschera

uguale al layer MaskSpirale e la chiamera Maska

Noi facciamo cosi, cioe clicchiamo sul layer MaskSpirale e facciamo ADD dalla finestra
fractal properties

Adesso pero noi dobbiamo togliere una maschera da quella struttura perché non ci serve |i
la maschera ma ci servira nel nuovo gruppo

Per un attimo togliamo le due maschere(TUTTE E DUE) ricliccando su USE AS MASK dalla
finestra fractal properties

Adesso spostiamo i layer maska

La Maska la spostiamo sopra il Group Spirale

Sulla MaskSpirale riclicchiamo USE AS MASK

Abbiamo fatto questa operazione perché cosi siamo piu precisi nel creare la maschera di
sfondo, perché non tocchiamo i punti di controllo della maschera ma invertiremo il
gradiente

Adesso quindi clicchiamo su Maska lo rinominiamo Mask Sfondo ed aggiungiamo un gruppo
che chimeremo Group Sfondo

Adesso dal layer Mask Sfondo clicchiamo use as mask e mascheriamo il nuovo gruppo che
per ora e vuoto

Dovreste avere I'lmmagine di prima

Perd manca una cosa, a noi interessa lo sfondo quindi la maschera deve essere invertita
Dal layer Mask Sfondo attivate il gradiente e dal menU GRADIENT—=2>INVERT

Avrete quindi questa immagine, diapositiva successiva
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Adesso non ci rimane altro che inserire i layers per lo sfondo

Ma noi possiamo usare tutte le formule che vogliamo non siamo obbligati ad
usare sempre la formula della spirale

Quindi dalla toolbar clicchiamo I'icona NEW FRACTAL andiamo nella cartella
SAM.UFM e scegliamo PIXEL(SLIGHT MOVE)

In Outside color clicchiamo su Browse andiamo nella cartella SAM.UCL e
scegliamo SFBM Il e mettiamo la TRASFER FUNTION=SIN

Apriamo il ?radlent di questo layer(new fractal) e lo rimpiazziamo con quello che
trovate nella mia cartella gradienti(tutorialz, Sfondo1) mettiamo una ROTATION
=192 al gradiente

Adesso clicchiamo sul layer con il pulsante dx e facciamo copy

Andiamo nella nostra immagine clicchiamo sul gruppo Group Sfondo e facciamo
PASTE

Inseriamo il layer(backgroud) nel Group Sfondo e lo rinominiamo Sfondo1
Andiamo un attimo nella location di Sfondo1 e la mettiamo uguale a quella dei
layer spirali cioe

= (Center=(-0.3, 0.0)

= Magnification = 1.4

= Rotation Angle = -90

Diapositiva successiva
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Adesso cliccando su Sfondo 1 aggiungiamo un layer1 lo chiameremo
Sfondo 2 e cambiamo solamente la rotazione del gradiente di Sfondo 2,
= rotation=-120 e cambiamo il merge di Sfondo 2

= merge mode=Color

Dal layer Sfondo 2 aggiungiamo un layer che chiameremo Sierpinski
Plane,dal browse della formula la cambiamo da Pixel(Slight Move) e
scegliamo sempre nella cartella SAM.UFM->Sierpinski Plane e nella
location di questo layer mettiamo:

= Center=(0.0,0.0)

= Magnification=1.0

= Rotation Angle =315

Nell'Outside color di Sierpinski Plane clicchiamo su Browse e dalla
STANDARD.UCL->Triangle Inequality Average

= Mettiamo [a TRANSFER FUNTION=SQRT
Apriamo il gradiente di questo layer Sierpinski Plane e mettiamo

- ROTATION = 45
- MERGE MODE = DIFFERENCE
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& ) Ultra Fractal
File Edit Fractal Animation Options Window Help
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Salvate come Tutoriala e la nostra immagine e
finita

L'immagine e racchiusa in due gruppi

E ordinata

Le aree di lavoro sono ben distribuite e divise
Ogni Layer ha un suo RUOLO

- Sivedono immagini con layer o merge mode che non hanno un
ruolo, € come mettere un pezzo di codice che non serve, a me non
piace.

Se la volete rende in Jpeg ricordate le
antialiasing e la size 8o0X500 Pixel
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Condividiamo i parametri dell'immagine, con la
finestra fractal attiva dal menu in EDIT si apre la
tendina e cliccate COPY e poi paste in qualsiasi
programma word o e.mail per condividere
Perimportare I'immagine invece dovete
selezionare tutto il codice dal TITOLO FINO

ALLA CHIUSURA DELLE PARENTES
con il pulsante dx del mouse copiate

GRAFFE e
DOI aprite

UF ed andate in EDIT>PASTE e inco

4 Creato da Andrea Spinozzi
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Se non riuscite a copiare il codice da qui,
scaricate il file in word dal mio sito o scaricate
la presentazione in PDF, da li potete copiare il
codice ed in EDIT->Paste del programma
incollate.

Ricordo di selezionare e copiare il codice dal
titolo fino alla chiusura della parentesi graffa.
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| plug-In sono librerie di classi e sono salvati in file .ulb(Ultra Frcatal Library)
Sono formule costruite in modo particolare per poter aggiungere funzionalita alla
formula senza il bisogno di ricopiare tutto il codice della formula per aggiungere i
cambiamenti

| plug-in ovviano a questo problema, se voglio aggiungere un particolare
cambiamento non devo riscrivere il codice della formula ed immettere il
cambiamento in tutto il codice, basta che scrivo un PLUG-IN ed inserisco il
cambiamento

Questo riesce a risolvere molti problemi, uno puo essere la compatibilita delle
formule aggiornate.

Inserire nuove funzionalita ed avere piu ordine nel mantenere il codice e nella
scrittura del codice

| plug-in sono in diverse cartelle tipo

= rebsg.ufm o ucl etc...

= standard.ufm, ucl etc...

= Dmijs.ufm o ucl etc...

Potete vedere dal browse

Facciamo un esempio

Andiamo in New Fractal>REB5.UFM e selezioniamo = Object Formula Switch
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Questo Plug-In (object Fomula Switch) puo
inserire diverse funzionalita

Come vedete nella formula abbiamo tre
oulsanti di BROWSE, che aprono i nostri
nossibili Plug-In

Primo Browse e riferito a delle PRE-
"RASFORMAZIONI

Il Secondo e riferito alla formula che vogliamo
usare

Il terzo e una POST-TRASFORMAZIONE

A Creato da Andrea Spinozzi




Possiamo inserire quindi tre plug-in.

Nella sezione di Pre-Trasformation clicchiamo sul
Browse ed andiamo nella cartella DMJ5.ULB ed
inseriamo MOSAIC.ULB

La Fractal Formula la lasciamo MANDELBROT JULIA
SWITCH (ma possiamo usarne anche altre se vogliamo)
Nella Post-Trasformation invece clicchiamo sul Browse
ed andiamo sempre in DMJ5.ULB ed inseriamo TRAP
TILING.

Adesso andiamo nell’Outside tab ed inseriamo un
colore, clicchiamo su Browse dell’'Outside ed andiamo in
DMJ5.UCL e inseriamo Orbit Traps Gradient (UF5)
Vediamo che abbiamo diversi plug-in da poter inserire,
per esempio se scendiamo con la scroll bar fino a Trap
Shape possiamo cambiare da Astroid a qualsiasi altro
colore presenti nelle cartelle .ulb, poi possiamo fare uno
switch e cosi via...
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Layer Properties - Fractall, Backeround

 Location iﬂa_ppjg_ ' Formula ‘Inside TOutside]

Object Formula Switch &
Drawing Method: [Multi-pass Linear M &
Periodicity Checking: [Off M @f
Additional Precision: P M ?

Maximum Iterations: {1000 R4

[ adjust Automatically

This is a fractal formula which can combine object Formulas
and provide switching between the mandel type and julia
type Forms of the formula(s), Transforms can also be
applied.

~ Mandglbrg

G
E""" j@errornulas

Fract... Mandelbrot Julia Switch &

The 'Manu errides the switching
capability of 'Object Formula Switch' and 'Object Formula
Switch Lite'. Use the normal switch capabilities instead
with these formulas,

For formulas can can use it, this plugin can calculate the
analytical derivative of the fractal.

[ IManual Switch

Bailou... [mod ﬁ

Bailou,.. |10000000000

Powe... |2
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Le formule Slope sono abbastanza usate, nella galleria
del mio sito troverete diverse Slope Images

Una slope formula usa tre vettori per colorare i pixel in
questo modo crea un effetto in “rilievo”

| colori usati nelle slope formule sono i colori
LIGHTING che trovate sia nella standard.ucl sia in
REB.UCL o DMJ.UCL o MMF 3D COLORING....Etc....
Facciamo un esempio aprite dalla cartella AS.ufm, File
New Fractal->Slope3D_Set e nell'outside color
inserite da REB.UCL->3D_Texturizer_Enhanced_lII
NB i LIGHTING COLOR LAVORANO SOLO CON
FORMULE 3D O SLOPE
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Le pixel formule sono usate per diversi motivi:

Vedere la forma PURA del colore

Se inseriamo un colore in un frattale MANDELBROT ovviamente la curva
si adeguera alla forma del frattale di Mandelbrot, con la PIXEL formula
possiamo invece dire che il colore sara visto con la sua FORMA BASE, per
esempio & usata per i textures.

Alcuni algoritmi colore lavorano SOLO con pixel formule

Facciamo un esempio andiamo in SAM.UFM->Pixel (2 iterations) e
nell'outside mettiamo da standard.ucl-> Orbit Traps, adesso se
cambiamo la trap shape vedremo la forma base del colore quindi in
RECTANGLE vedremo che I'agoritmo crea un rettangolo e cosi via..
Sempre con la Pixel(2lterations) nell’Outside color andiamo in reb.ucl ed
inseriamo LINE ART, questo colore per esempio lavora solo con la Pixel
formula.Ma anche altri colori tipo le Perle di Indra lavorano con formule
Pixel proprio per avere l'utilizzo PURO del colore senza interferenze della
formula.
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Abbiamo visto una buona parte di UF pero le
potenzialita di questo programma sono infinite, ed
infatti non abbiamo parlato di tantissime cose ma non
fineremmo piu quindi per ora concludiamo qui.

Il mio consiglio e quello di “esplorare” e trovare il
vostro metodo e stile di lavoro

Ultimo esempio perinserire una JPEG O PNG ETC..
fate una prova prendete una formula

Pixel(2Iterations) va bene

Andate nell'outside color prendete da REB.ucl>IMAGE

TILES e vedrete che nel plug in potete inserire una jpeg,
png etc....
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Per qualsiasi problema potete scrivere in lista:

| parametri che sono condivisi nella lista NON SONO LIBERI DIUTILIZZO
A MENO CHE NON VENGA DETTO, quindi NON potete prendere dei
layers o modificare un‘immagine senza che LAUTORE LO SAPPIA.

Le immagini sono coperte da COPYRIGHT e se un‘immagine viene messa
in lista e si puo TWEAKKARE(tweak) pizzicare, modificare, I'immagine
tweakkata VA RIPOSTATA IN LISTA e nel titolo aggiungere le iniziali del
vostro nome, tipo TUTORIAL+AS

Non prendete layer che non vi sono permessi, usate le vostre immagini e
laVOSTRA ARTE e anche molto piU SODDISFACENTE non credete?
Detto questo la fantasia e la possibilita di creare arte in UF non trova
limitazioni, ci sono miriadi di formule, colori, trasformazioni, possibilita,
implementazioni, etc...

DIVERTITEVI AD ESPLORARE IL
MAGNIFICO MONDO DEI FRATTALI
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nttp://digiland

= Fractalia, sito molto utile che spiega anche
'editor di UF, per |la versione 3.0:

er.libero.it/fractalia/Tutorial Ul

trafractal/tuto

rialultrafractal.html

= REB formule, Ronald Barnett tutorial slope:
http://hiddendimension.com/Tutorials/Tutori

als Main.htm

HAVE GOOD FRACTAL TIME
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http://digilander.libero.it/fractalia/Tutorial_Ultrafractal/tutorialultrafractal.html
http://digilander.libero.it/fractalia/Tutorial_Ultrafractal/tutorialultrafractal.html
http://hiddendimension.com/Tutorials/Tutorials_Main.html
http://hiddendimension.com/Tutorials/Tutorials_Main.html

